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Movement in 3D Space

Learning from Existing Animations 

On the MoviePack CD there are lots of example animations and
transitions. 

Transitions, whose appearance and effect can be modified by adjusting
effect parameters or by applying other effects, can be used to pep up
your films and videos. 

Animations can also be used to spice up your creations. Animations are
built from several objects and effects and you will soon learn how to
create your own by following our examples. 

Important Please read the "Tutorial - The Interface" booklet before beginning
"Animations" as you will be using the MoviePack interface described
therein in the following tutorial. A new animation will also be needed
in the Canvas window. 

Our Aim In this booklet you will learn how to: 

● Open and examine animations 

● Reproduce animations 
Manual Tutorial Reference Effects
Movement in 3D Space
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● Copy effects and objects 

● Substitute objects

Preparation The MoviePack interface we will use is the same as the one described
in the "Tutorial - The Interface" booklet. In the Canvas the animation
"Tut_Cube.M3" from "Samples" will be used.

u Close any existing animations with the command Close
(shortcut Ctrl+F4) from the File menu.

Save all existing animations. 

Project Management  In order to simplify working with animations, a ready-made project will
be used. Many MoviePack settings (window size and position, options,
browser settings etc.) can be saved in so-called projects. A project with
pre-determined settings can be loaded with a few clicks of the mouse. 

For the animation "Tut_Cube.M3", the project "Tut_Cube.M3W" saved
in "Samples" is needed. 

u From the File menu
select the command
Open Project.  

In the Open Project dialog box the desired drive, folder and project can
be selected.  

u Select the "Samples" folder in the Open Project dialog box. 

Tut_file_001_E.tif

Project_Open_Project_E.tif
Tut_Cube.m3w
Movement in 3D Space
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u Open the "Tut_Cube.M3W" project.

After opening the file (either double-click the file or click the file then the
Open button) MoviePack reloads all the settings as they were when you
saved before quitting. Any animations and transitions which were
saved in the project are also opened. 

Opening Animations  Animations can also be opened using existing MoviePack settings. 

u Click the icon Open on the MoviePack icon bar. 

or 

u From the File menu select Open (shortcut Ctrl+O ). 

Animations, transitions, projects and other MoviePack files can be
selected from any drive and folder using the Open dialog box. 

u Select the "Samples" folder from the Open dialog box.

u Click the "Tut_Cube.M3" animation. 

In the preview window of the Open dialog box, the frame over which the
Timeslider in the Timeline was positioned when saving the animation is
shown. 

You can quickly access all MoviePack files saved on your drives. The pre-
view and the file filter ensure quick and easy access to the correct file (file 
type), whether it is an animation, transition or project. 

File type filter Preview window

Select Folder  Create Folder Activate PreviewFile_Open_Animation_001_E
.tif
Tut_Cube.m3w
Manual Tutorial Reference Effects
Movement in 3D Space
Animations TUT



   
I Before saving your animation position the Timeslider over a
distinctive frame so that the animation will be easy to find at
a later stage. 

Double-click the desired file (or click the file, then Open) to load the
animation. The animation can then be analysed and altered.   

The "Tut_Cube.M3" animation from "Samples" is shown. The preview
gives you an idea of how the animation looks. 

u Click Play in the Preview. 

Tut_Cube_001_E.tif
Tut_Cube.m3w
Movement in 3D Space
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A die rotates on the horizontal axis and movie clips are stuck to the four
faces of the die.   

If the die does not rotate completely, it means that only a part of the
animation has been selected in the preview area. The preview area is
represented by the green bar in the timescale of the Timeline.   

The preview area must extend from the beginning to the end of the
animation if you want to see the entire preview. 

u Double-click the preview area in the Timeline. 

I Each double-click in the preview area alternates between the
partial and entire preview. 

Studying Animations  Let’s take a closer look at this interesting little animation and try to work
out how it was put together. 

There are 4 different clips in 5 Tracks in the Timeline. 

If the scale of the Timeline is too small to see details like the file name of
the movie clip, it can be changed using the zoom buttons. 

u Click  in the Timeline.

Tut_Cube_Preview_002_X.tif-
bis 
Tut_Cube_Preview_005_X.tif
Tut_Cube.m3w

Preview Area

Double-click the green bar of the preview area to alternate between the 
partial preview and the entire preview. 

 
Tut_Cube_Timeline_009_G.tif
Tut_Cube_001.m3w
Manual Tutorial Reference Effects
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The scale becomes greater with each click. If the scale is too large it can
be easily reduced again. 

u Click  in the Timeline.

Movie Clips in the Effet Box  How was the "Tut_Cube.M3" animation put together? Let’s take a look
at each object individually and the effects applied to them, along with
the effect parameters in the Effect Box. 

u Click the top object in the Timeline, the "Cube_4.avi" movie
clip.

u Click the Timeslider in the Timeline and move it back and
forwards between the first frame and the last frame of the
clip. 

The object turns out to be a face of the die. The object borders rotate
on the horizontal axis in the Canvas. 

On the icon bar of the Effect Box there are three icons for this clip: 

for the Movie Clip object

for existing Transformations 

for the Correction by Z effect from the 3D FX effect group

To rotate the die face, the parameters under the Rotate tab of
Transformations must be altered. 

u Click icon Transformations in the Effect Box.

u In Transformations, click the Rotate tab.

u In the Timeline slowly move the Timeslider from the first frame
to the last frame of the active clip.

u Observe the changes in the Effect Box.

The value for rotation on the horizontal X axis increases in proportion
to the time change of X = 3.27 ° in the 1st frame up to X = 78.5 ° in
the last (24th) frame. This is approximately a 1/4 turn.

The second visible face of the die makes a 1/2 turn.

u Click the second movie clip, "Cube_3.avi", in the Timeline. 
Movement in 3D Space
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u Click icon Transformations in the Effect Box.

u In Transformations, click the Rotate tab.

u In the Timeline slowly move the Timeslider from the first frame
to the last frame of the active clip.

u Observe the changes in the Effect Box.

The value for rotation on the horizontal X axis increases in proportion
to the time change of X = –78.5 ° in the 1st frame up to X =  78.5 ° in
the last (49th) frame.

Depth Displacement In addition to simple rotation it is also possible to move all clips on the
Z axis in the Canvas. This is made possible by the Correction by Z effect. 

u In the Effect Box, click the third icon, Correction by Z. 

u In the Timeline slowly move the Timeslider from the first frame
to the last frame of the active clip. 

u Observe the changes in the Effect Box. 

The Correction by Z effect has only
one parameter, Amplitude. The
Amplitude has a constant value of
100 throughout.  

This movement on the Z axis is not linked to any other effect or
movement. 

I Without any other movement, different Amplitude values for
Correction by Z result in the clip moving away from or
approaching the camera. 

Imagine the cube rotating on the central horizontal axis, so that the four
faces of the cube, which are parallel to the rotation axis, always keep
the same distance from the rotation axis. 

After studying the other objects and their parameter changes (Rotate in
Transformations and Amplitude of Correction by Z), it is obvious that the same
effects have been applied to all the objects and the parameter changes

Tut_Cube_effectbox_001_E.t
if
Tut_Cube_001.m3w
Manual Tutorial Reference Effects
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are identical, because all the faces of the cube behave in exactly the
same way but are only visible now and then. 

Only the topmost and bottommost objects are exceptions - the topmost
object is already visible at the beginning of the animation and spins
downwards, the bottommost object comes into view in the last quarter
of the animation. These two objects can also be compared with the
middle objects - the top object behaves identically to the first half of the
middle objects and the bottom object behaves identically to the second
half. 

Do it YourselfThis interesting creation can be put together quickly and easily:

● In the Timeline four movie clips, "Cube_1.avi" to
"Cube_4.avi" from "Samples", are needed. 

● The clips are different lengths and have to be trimmed to the
same length. 

● Apply the Correction by Z effect from the 3D FX group in the
Browser to each object. 

● The rotation is adjusted in Transformations.

New Animations  Each new animation has to be set up. 

u Click icon New Animation in the MoviePack icon bar.

u In the resulting Animation Setup dialog box select PAL (or NTSC)
on the Time tab.

The clips to be inserted have a resolution of 320 x 240 pixels and their
size should not be altered, otherwise the Canvas itself has to be enlarged. 

u In the Page tab select Multimedia High, 640 x 480 in the Size field. 

Clips should be set against a white background.

u Click the button  Background Color. 

u In the Select Color dialog box use the HSB color model, click
the Saturation/Brightness combi-slider and drag it to the white
area. 
Movement in 3D Space
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I If you save these settings under a suitable name, "PAL-High-
White" (Tab Schemes, Save as... ), new animations can be
loaded with these settings (schemes). 

In the Timeline four movie clips, "Cube_1.avi" to "Cube_4.avi" from
"Samples", are required.

u In the Browser, click the Movie Clip [Samples] tab.

u In the Browser, scroll downwards using the scroll bar on the
right-hand side until the thumbnail of the "Cube_4.avi" clip
is visible.

u Click the "Cube_1.avi" thumbnail and drag it into the Video1
track on the Timeline, so that the black object bar begins at
0:00:00:00. 

u Click the "Cube_2.avi" thumbnail and drag it into the Video1
track on the Timeline, so that the black object bar begins at
0:00:00:00.

A new track, Video2,is automatically inserted into the Timeline. 

Insert the "Cube_3.avi" clip over the Video2 track and "Cube_4.avi" clip
over the Video3 track and new tracks will automatically be inserted as
above. 
Manual Tutorial Reference Effects
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Trimming Clips  In the Timeline the four clips are now lying one on top of each other. They
are different lengths and have an uneven number of frames and
therefore have to be trimmed.  

u In the Timeline, click the right-hand trim button, Trim to end .

u In the Timeline, position the pointer over the end of the
"Cube_1.avi" clip.

The pointer changes into a trimming icon. A vertical line
indicates the time where the clip is to be trimmed.  

u In the Timeline, click on the "Cube_1.avi" clip, at
0:00:01:24.

The "Cube_1.avi" clip is trimmed to a length of 1 s and 24 frames. In
one second 25 frames are shown meaning that this clip now consists of
49 frames.

The clips "Cube_2.avi" to "Cube_4.avi" should be trimmed in the same
way. 

If the beginning of the clip is to be trimmed, select the left-
hand trim button Trim to Beginning.  

Trim buttons

and

Pointers for trimming

Trim to Beginning
Cut

Trim to End

All clips are trimmed to the 
same length from 
0:00:01:24 to the end.

In the Timeline clips can be trimmed using the mouse as a pair of scissors in 
both the editing and compositing areas. 

 
Tut_Cube_Timeline_002_G.tif
Tut_Cube_001.m3w
Movement in 3D Space
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Depth Displacement Apply the Correction by Z effect from the 3D FX group to each clip and set
the Amplitude to 100.

u In the Browser, click the Effects tab. 

u In the Effects, folder click the icon 3D FX. 

u In the effect group 3D FX click the icon  Correction by Z and
drag it onto the bottom clip, "Cube_1.avi", in the Timeline. 

The Amplitude parameter causes a
virtual movement of the object on
the perpendicular Z axis.
Provided the object remains still,
positve values result in the object
approaching the camera and for
negative values the opposite is
true.

u In the Timeline, position the Timeslider to 0:00:00:00.

u In the Effect Box , set the Amplitude to 100. 

u In the Timeline, set the Timeslider to 0:00:01:23.

u In the Effect Box, set the Amplitude to 100. 

Copying Effects After setting the amplitude to 100 for the "Cube_1.avi" clip, this effect
can be applied to the other three clips. 

I An effect and its parameters applied to a clip can be copied
and applied to other clips. 

u In the Timeline, click the "Cube_1.avi" clip.

u In the Effect Box, click the third icon, Correction by Z.

u From the Edit menu select the Copy command (shortcut Ctrl+C).

or

u On the icon bar click the icon Copy.

The effect is copied to the WINDOWS clipboard.

u In the Timeline, click the "Cube_2.avi" clip.

u From the Edit menu select the Paste command (shortcut Ctrl+V).

Tut_Cube_Effectbox_002_E.T
IF
Tut_Cube_001.m3w
Manual Tutorial Reference Effects
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or 

u On the icon bar click the icon Paste.

The effect is inserted from the WINDOWS clipboard into the
"Cube_2.avi" clip. 

I The effect is not deleted from the clipboard (until another
marker is copied) so it can be applied to the other two clips
as well. 

u In the Timeline click "Cube_3.avi". 

u On the icon bar click icon Paste.

u In the Timeline click "Cube_4.avi". 

u On the icon bar click icon  Paste.

All clips are now uniformly displaced on the Z axis. 

Rotating ObjectsThe clips must now be rotated on the X axis.

u In the Timeline, set the Timeslider to 0:00:00:00.

u In the Timeline, click "Cube_1.avi". 

u In the Effect Box, click the icon Transformations.

u In Transformations, click the Rotate tab.

The object can be rotated using
the slider around the globe
(yellow ball) or the globe itself.   

For more precise settings the
angle and number of rotations
can be entered numerically
using the keyboard. 

 tut_cube_effectbox_003_E.tif
Tut_Cube_001.m3w
Movement in 3D Space
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u For the rotation X enter 0 rotations and –78.5 °. 

u In the Timeline, set the Timeslider to 0:00:01:23. 

u For the rotation X enter 0 rotations and 78.5 °. 

The four faces of the cube should behave uniformly so the movement of
the first clip has to be transfered to those of the other faces. 

u In the Timeline, click the "Cube_1.avi" clip.

u In the Effect Box, click the icon Transformations.

u In the icon bar click the icon Copy. 

The movement is saved to the WINDOWS clipboard.

u In the Timeline, click the "Cube_2.avi" clip

u In the icon bar click the icon Paste 

The movement is copied to "Cube_2.avi". Clips "Cube_3.avi" and
"Cube_4.avi" can be manipulated in the same way.

Temporal Movement of 
Objects

In the preview you can see how the "Cube_4.avi" clip moves and rolls
forward like a real die. 

u Click Play in the Preview window.

As the three other clips are positioned directly under the top clip and
mirror its behavior (the parameter values of the effect have been
copied), they are not visible at present.

I If more than one clip is constantly or occasionally visible,
something is wrong. The movement or rotation has not been
copied to this clip and the above steps must be repeated. 

If the movement of all the clips is synchronized, the clips can now be
temporally displaced. 

u In the Timeline, click the "Cube_2.avi" clip and drag it to the
right within the Video2 track so that it begins at 0:00:01:00. 

u In the Timeline, click the "Cube_1.avi" clip and drag it to the
right so that it begins at 0:00:02:00. 
Manual Tutorial Reference Effects
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u In the Timeline, click the "Cube_4.avi" clip and drag it to the
left so that it begins at -0:00:01:00. 

u Click Play in the Preview window.

In the preview you will see that all the clips behave like a real die.
However, a link is missing at the beginning and the end - the die is not
yet closed. 

Cutting Clips It is very easy to create this link - the first 25 frames of the "Cube_4.avi"
clip, which lie in the negative area have to be cut away and inserted at
the end of the animation. 

u In the Timeline, click clip "Cube_4.avi". 

u On the icon bar of the Timeline click the middle Cut button.

u Position the pointer over the clip in the Timeline.

The pointer changes into a pair of scissors. A vertical line
indicates, on the timescale, where the clip will be cut.  

u Click the mouse at 0:00:00:00.  

The clip is divided into two separate pieces which can be treated as two
separate objects. 

I Note that the effects applied to the object up to now are not
affected and the parameter changes are transferred
correspondingly. 

Cut button

and

Cutting pointer

Cut button, to the left and right are the Trim buttons
 tut_cube_timeline_003_g.tif
Tut_Cube_001.m3w
Movement in 3D Space
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The left-hand section is then moved to the end of the clip in the bottom
track, as follows. 

u In the Timeline, set the Timeslider to 0:00:03:00  

u In the Timeline, click the left section of the "Cube_4.avi" clip
and drag it between Video1 and Video A so that it begins at
0:00:03:00. 

A new track appears where the left-hand side of "Cube_4.avi" is
inserted.  

u Click Play in the Preview window. 

All four sides behave identically and are postioned in the Timeline so that
the four faces of the die roll smoothly. 

The animation has now been successfully reproduced. You can
experiment further with this little animation. This is the best way to learn
other techniques.

Copying Objects Besides effects, complete objects, including the effects applied to them
and their parameter changes, can also be copied and multiplied.

For example, the second face of the die can be copied and then
inserted between the current fourth and bottom faces. 

u In the Timeline, click clip "Cube_3.avi". 

u On the standard menu bar click icon Copy (shortcut
Ctrl+C).

The "Cube_3.avi" clip has been copied to the clipboard and can be
inserted anywhere within the Timeline. 

 tut_cube_timeline_001_g.tif
Tut_Cube_001.m3w
Manual Tutorial Reference Effects
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u In the Timeline, set the Timeslider to 0:00:03:00. 

u On the standard menu bar click icon Paste (shortcut
Ctrl+V).  

The copied clip is inserted into the track to the right of the Timeslider.
This clip must also behave like the others so another two alterations are
necessary. 

u In the Timeline, click the inserted "Cube_3.avi" clip and drag
it between Video1 and Video5 so that it begins at 0:00:03:00. 

A new track Video6 is added for the new clip. The bottom clip must be
moved 1 second to the right. 

u In the Timeline, set the Timeslider to 0:00:04:00. 

u In the Timeline, click the bottom "Cube_4.avi" clip and drag
it in the Video5 track to the right so that it begins at
0:00:04:00. 

The previous cascading order of the clips in the tracks has been
restored.  

u Press  Play in the Preview window.

 tut_cube_timeline_004_g.tif
Tut_Cube_001.m3w

 tut_cube_timeline_005_g.tif
Tut_Cube_001.m3w
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In the Preview we can see a rolling die with five faces, the second face
appears again as the fifth. Other clips can be copied and inserted at
different times and in different tracks. 

Replacing Objects Objects in animations can be swapped with other objects such as
movie clips, still images or generated objects (Text String and Titler, Color
Ramp, Random Generator, Video Noise etc.). 

The next step is to determine the size and the length of the clips.

u In the Browser, click the Movie Clip [Samples] tab and then the
thumbnail of the file "Cube_3.avi".

The bottom line of the
Browser shows the
properties of the
highlighted object.  

For clips and
transitions the length
in seconds, the size in
pixels and the frame
rate in frames per
second are shown,
while only the name

and the size in pixels of an image are shown.    

I The file extensions (avi, mov, ... , bmp, tif, ...) indicate the file
format.

When searching for another clip, each file in "Samples" can be
selected to show its size and length in the properties line of the Browser.

The "Lions.avi" clip is the ideal size and is almost the length we need.
The clip can be previewed in the source preview.

u In the Browser activate the source preview by clicking the icon
 Enable Source Viewer.

 tut_cube_browser_002_E.tif
Tut_Cube_001.m3w

Tut_Cube_Browser_001_E.tif
Tut_Properties_Clip_001_E.tif
Tut_Properties_Image_001_E.
tif
Tut_Cube2_001.m3w
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u In the Browser, position the pointer over the thumbnail of the
"Lions.avi" clip.  

This clip will now replace the bottom "Cube_3.avi" clip.

u In the Timeline, click the bottom "Cube_3.avi" clip.

u In the Timeline, position the Timeslider to 0:00:03:00. 

u In the Effect Box, click the icon  Movie Clip.

u In the Effect Box , select Change.... 

The "Lions.avi" clip is shown in the source 
preview in the Browser, and its properties are 
shown in the properties line at the bottom of 
the Browser.

Tut_Cube_Preview_001_E.tif
Tut_Cube2_001.m3w
Lions.avi
Tut_Properties_Clip_002_E.tif

Icon bar of the Effect Box

Objects can be swapped using 
the Change button. 

tut_cube_effectbox_004_E.tif
Movement in 3D Space
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Choose Source The Choose Source dialog box allows you to select another clip from a
selection of other sources. 

u In the Choose Source dialog box select  Movie Clip and then
click Next.

The Open dialog box allows you to select the desired clip. 

u In the Open dialog box select the "Samples" folder and then
select the "Lions.avi" file. 

If the preview is active the first frame of the clip is shown in the small
preview window. 

u Open the "Lions.avi" movie clip.

In the next dialog box, Choose File, the file name is shown for the last
time. If you have selected the wrong clip you can go back using the
<Back button to select another file.   

Every source can be exchanged for another object. 

Tut_Select_Source_E.tif

Tut_Open_Clip_E.tif
Tut_Cube2_001.m3w
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u In the Choose File dialog box click Finish.   

I Another clip can be selected by clicking File. 

I Another source (another object) can be selected by clicking
<Back.

The "Lions.avi" clip replaces the "Cube_3.avi" clip.   

u Press Play in the Preview window. 

The new clip adopts all the settings of the former clip and fits seamlessly
into the clip sequence. 

Now you know just how easy it is to replace one object in an existing
animation with another, whether the object is a clip, photo or generated
object. 

In the Timeline, if you position the pointer over the object bar you will see
that the inserted "Lions.avi" clip is now 1 s and 24 frames or 49 frames
long (at a frame rate of 25 frames per second). 

Choose_So
urce_End_E
.TIF

 tut_cube_timeline_006_g.tif
Tut_Cube_001.m3w
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u In the Timeline position the pointer over the "Cube_3.avi"
movie clip and the tool tip will pop up.   

In the properties line of the Browser the length of the clip is shown as
3,8 s (3 s and 20 frames or 95 frames).   

I If the objects are of different lengths, the length of the second
object will be stretched or compressed to the length of the
first object. 

The resulting changes to "Tut_Cube.M3" (Die with 5 clips)
will be saved in "Samples" under "Tut_Cube5.M3", the
project under "Tut_Cube5.M3W".   

Animations in the Animation 

Integrating simple animations into our compositions

Something New In our animations so far, just clips or photos from external objects (i.e.
files saved on the hard disk or CD...) have been used. 

However, each MoviePack animation can be saved and then inserted
into other animations in its entirety, like an individual object, as an
embedded scene. 

Drive\Folder\Name of Object \ Beginning - End \ Length 
(in hours:minutes:seconds:frames) of the object are shown in the Timeline if the 
pointer is positioned over the object bar.

tut_cube_timeline_007_g.tif
tut_cube_timeline_008_g.tif
Tut_Cube_001.m3w

Tut_Properties_Clip_002_E.tif
Tut_Cube2_001.m3w
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PreparationThe MoviePack interface used to do this is the same as the one
described in the "Tutorial - The Interface" booklet. A new animation is
needed in the Canvas window.

u Close any existing animations with the Close command
(shortcut Ctrl+F4) from the File menu.

Save all exisitng animations under a suitable name and in a suitable
folder. 

u Click icon New Animation in the MoviePack icon bar.

u In the following Animation Setup dialog box select PAL (or NTSC)
in the Time tab.

u In the Page tab select Multimedia Medium, 320 x 240 in Size field.

u Click the button  Background Color.

u In the Select Color dialog box use the HSB color model, click
the Saturation/Brightness combi-slider and drag it to the white
area.

I If you save these settings under a suitable name, say "PAL-
High-White" (Tab Schemes, Save as... ), new animations can be
loaded with these settings (schemes).

Integrating Animations as 
Scenes  

Saved animations are considered as external objects and can be
accessed from the Browser. The "Tut_Cube.M3" animation from
"Samples" will serve as our example. 

u Create a new tab in the Browser by clicking the Add Tab
icon.

u In Root double-click the icon Objects.

u In the Objects folder double-click the icon All Objects.

u In the All Objects folder double-click the icon
Generated Scene (animations or scenes created with

MoviePack).

u Double-click the icon  Desktop.

u Double-click the icon (X:) (drive where the examples are
saved).

u Double-click the icon Samples (the folder where the
examples are saved). 
Animations in the Animation
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In the
Generated Scene
[Samples] folder
all the
animations from
"Samples" are
mapped and
can be
integrated into
other animations
as scenes.   

u In Browser, scroll downwards until the thumbnail for the
"Tut_Cube.M3" animation is completely visible.

u Click the thumbnail for the scene "Tut_Cube.M3". 

Again, in the properties line at the bottom of the Browser the name, size,
length and frame rate of the animation are shown. 

u Click the "Tut_Cube.M3" scene and drag it into the Video1
track in the Timeline so that the left-hand side of the object bar
begins at 0:00:00:00. 

In the Timeline there is only one object bar which contains all the
elements of the "Tut_Cube.M3" animation (objects, transitions as well
as the applied effects).

Tut_Config_Browser_003_E.ti
f
Tut_Cube3_003.m3w
Manual Tutorial Reference Effects
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In the Canvas, at a size of 320 x 240 pixels, you can see a clip of the
original animation which is 640 x 480 pixels.  

u Press  Play in the Preview window. 

In the Preview you can see the rolling die which is twice the normal size
due to the difference in scale of the original animation and the current
Canvas. 

Adjusting the First FrameBy making the die smaller at the beginning of the new animation and
positioning it at the top edge of the Canvas, it will roll forwards while
increasing in size.

u In the Timeline, position the Timeslider to 0:00:00:00. 

u In the Effect Box, click the icon Transformations. 

u In Transformations, select the Scale tab.

The Scale slider is positioned at 1.

u In the Effect Box, set the Scale slider to approx. 0,1. 

u In Transformations, select the Position tab.

The die is in the center of the Canvas at X = 0 and Y = 0.

Tut_Config_Canvas_004_G.tif
Tut_Cube3_003.m3w
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u Using the vertical slider move the center upwards to the
coordinates X = 0 and Y = 100.   

The settings for the first frame of the animation are now complete. The
die is now small and positioned at the top edge of the Canvas. 

Adjusting the Last Frame The last frame can also be quickly adjusted. 

u In the Timeline, positon the Timeslider to 0:00:04:00. 

u In Transformations, select the Scale tab.

The Scale slider is positioned at 1.

u In Transformations, select the tab Position.

The die is in the center of the Canvas at X = 0 und Y = 0.

u Using the vertical slider move the center downwards to the
coordinates X = 0 und Y = --50. 

Tut_Cube_Canvas_002_G.tif
Tut_Cube3.m3w
Manual Tutorial Reference Effects
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The settings for the last frame of the animation are now complete. The
die is now large and positioned at the bottom edge of the Canvas.   

The die rotates on the horizontal axis from top to bottom. As it increases
in size it seems as if it is approaching the camera. 

The resulting modifications of "Tut_Cube.M3" are saved in
"Samples" under "Tut_Cube2.M3", the project under
"Tut_Cube2.M3W".  

Playing Scenes BackwardsThe natural frame sequence of a clip or scene can be altered very easily
in MoviePack.

Create a new 320 x 240 pixels animation with 25 frames/seconds
against a white background. 

Import the animation we have just created, "Tut_Cube2.M3W", as a
scene in the Video1 track.

u In the Browser, select the Generated Scene [Samples] tab.

u Scroll downwards until the thumbnail for the
"Tut_Cube2.M3" animation is completely visible.

Tut_Cube_Canvas_003_G.tif
Tut_Cube3.m3w
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Tut_Cube2.M3
Tut_Cube2.M3W
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u Click scene "Tut_Cube2.M3" and drag it into the Video1 track
in the Timeline so that the black object bar begins at
0:00:00:00. 

In the Timeline the "Tut_Cube2.M3" animation appears as a completely
embedded scene. The die rotates on the horizontal axis from top to
bottom and increases in size. 

Now we are going to reverse the frame sequence.

u In the Timeline, position the Timeslider to 0:00:00:00.

u In the Effect Box, click the icon Generated Scene. 

The time display in the Effect Box is at 0:00:00:00, the beginning of the
scene. The Scene Time slider is set to the far left.   

Position the Timeslider in the Timeline to another point in time and you
will see that the time display and the Scene Time slider in the Effect Box
move accordingly. 

At the end of the animation the scene time is 0:00.03:24, and the Scene
Time slider is now at the far right. 

u In the Timeline, move
the Timeslider to
another point in time.

u Observe the Scene
Time slider and the
digital display in the
Effect Box.

The frame sequence is reversed
if the end of the scene is
allocated to the beginning of the
animation and the beginning of the scene to the end of the animation.
The scene runs backwards in the animation. 

Tut_Cube_effectbox_011_E.tif
Tut_Cube3.m3w
Manual Tutorial Reference Effects
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u In the Timeline position
the Timeslider to
0:00:00:00.   

u In the Effect Box move
the Scene Time slider
from left to right to
0:00.03:24. 

The end of the scene is allocated
to the beginning of the
animation. 

u In the Timeline position
the Timeslider to
0:00:03:24. 

u In the Effect Box move
the Scene Time slider
from right to left
0:00:00:00
(beginning of the
scene). 

The beginning of the scene is
allocated to the end of the
animation.  

The frame sequence of the
integrated scene is now completely reversed. In the preview the die
moves backwards. 

The resulting modifications to "Tut_Cube2.M3" are saved in
"Samples" under "Tut_Cube3.M3", the project under
"Tut_Cube3.M3W".  

Altering Integrated ScenesThe objects and effects which make up the scene can be edited
separatetly. 

u In the Timeline, double-click the "Tut_Cube2" object.

Tut_Cube_effectbox_012_E.tif
Tut_Cube3.m3w

Tut_Cube_effectbox_011_E.tif 
Tut_Cube3.m3w
Tut_Cube2.M3
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Tut_Cube3.M3
Tut_Cube3.M3W
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The scene is opened in a different window. As "Tut_Cube2" also comes
from a scene "Tut_Cube", it can be opened in the same way. 

u In the Timeline, double-click the object "Tut_Cube". 

This scene is, in turn, opened in a separate window as an animation
with all the objects and effects, which can be manipulated in the usual
way. 

I The changes to the objects of the scene are only saved in the
animation which contains the scene ("Tut_Cube2" or
"Tut_Cube3") and not in the original animation
("Tut_Cube"). 

Step-By-Step You are now ready to investigate all the many animations on the
MoviePack CD and to insert your own image and video material. 

Creating your own animations should now be a breeze. 

ï Your creativity knows no bounds with MoviePack. 
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